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OVERVIEW OF IMMUNOFLUORESCENCE ASSAY FOR BIOPSIES 
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1.0 PURPOSE 

To standardize immunohistochemical methods to detect and quantify histone H2AX phosphorylated at 
serine 139 (γH2AX) and NBS1 phosphorylated at serine 343 (pNBS1) using β-Catenin tumor 
segmentation for pharmacodynamic (PD) evaluation of DNA damage repair status for formalin-fixed 
paraffin-embedded (FFPE) tissue biopsy sections.  The goal of the SOP and associated training is to 
ensure consistency of biomarker measurements between operators and clinical sites. 

2.0 SCOPE 

This procedure applies to all personnel involved in the use of the γH2AX, pNBS1 IFA with β-Catenin 
Segmentation for Tumor Biopsy Slides from patients participating in clinical trials.  This SOP outlines the 
recommended procedure for image extraction and analysis from whole slide image capture of stained, 
paraffin-embedded tumor biopsy sections.   

3.0 ABBREVIATIONS 

Ab = Antibody 
DAPI = 4',6-Diamidino-2-Phenylindole 
DCTD = Division of Cancer Treatment and Diagnosis 
FFPE = Formalin-fixed paraffin-embedded tissue 
γH2AX = Histone H2AX Phosphorylated at Serine 139 
H&E = Hematoxylin and Eosin 
IFA = Immunofluorescence Assay 
LHTP = Laboratory of Human Toxicology & Pharmacology 
NCTVL = National Clinical Target Validation Laboratory 
PADIS = Pharmacodynamic Assay Development and Implementation Section 
pNBS1 = NBS1 phosphorylated at serine 343 
QC 
ROI 

= 
= 

Quality Control 
Region of Interest 

SOP 
SVS 

= 
= 

Standard Operating Procedure 
Scientific Visualization Studio 

4.0 INTRODUCTION 

The γH2AX, pNBS1 IFA with β-Catenin segmentation is an immunohistochemistry-based staining assay 
developed to quantify γH2AX and pNBS1 using β-Catenin staining.  Staining with β-Catenin provides 
tumor area masking and is used, together with pathologist annotation, to define the areas in which γH2AX 
and pNBS1 are quantitated.   
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5.0 ROLES AND RESPONSIBILITIES 

Laboratory Director/Supervisor The Laboratory Director/Supervisor directs laboratory operations, 
supervises technical personnel and reporting of findings, and is 
responsible for the proper performance of all laboratory procedures.  
The Laboratory Director/Supervisor oversees the personnel who follow 
the SOPs within the laboratory and is responsible for ensuring the 
personnel are certified and have sufficient experience to handle clinical 
samples. 

Certified Assay Operator  A Certified Assay Operator may be a Laboratory Technician/ 
Technologist, Research Associate, or Laboratory Scientist who has 
been certified through DCTD training on this SOP.  The Certified 
Assay Operator works under the guidance of the Laboratory 
Director/Supervisor.  This person performs laboratory procedures and 
examinations in accordance with the current SOP(s), as well as any 
other procedures conducted by a laboratory, including maintaining 
equipment and records and performing quality assurance activities 
related to performance.  

 It is the responsibility of the Laboratory Director/Supervisor to ensure that all personnel have 
documented training and qualification on this SOP prior to the actual handling and processing of 
samples from clinical trial patients.  The Laboratory Director/Supervisor is responsible for 
ensuring the Certified Assay Operator running the SOP has sufficient experience to handle and 
analyze clinical samples. 

 The Certified Assay Operator for this SOP should be well versed and comfortable with light 
microscopy techniques, slide scanning techniques, as well as have familiarity with the Definiens 
Tissue Studio Software for image analysis. 

 The Certified Assay Operator responsible for conducting the assay is to follow this SOP with 
associated addendum and complete the required tasks and associated documentation.  The Batch 
Record (Appendix 1) must be completed in real-time for each experimental run, with each page 
dated and initialed.  

 All responsible personnel are to check the DCTD Biomarkers website 
(https://dctd.cancer.gov/ResearchResources/ResearchResources-biomarkers.htm) to verify that 
the most recent version of this SOP is being used. 

https://dctd.cancer.gov/ResearchResources/ResearchResources-biomarkers.htm
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6.0 MATERIALS AND EQUIPMENT REQUIRED 

 Aperio eSlide Manager software 

 Aperio ImageScope software 

 Definiens Architect DDR BUILD; Tissue Studio Analysis software 

 Microsoft Excel 2010 or higher software  

 Whole slide images of stained clinical sample and control slides imaged according to SOP340544 

 SOP340545 Excel Master Template 

 PC 
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7.0 OPERATING PROCEDURES 

 The Batch Record (Appendix 1) for image analysis should be completed to document image 
extraction and analysis for a single patient’s data. 

 Record the Facility/Laboratory Name, Assay Operator performing the image extraction 
and quantitation and the date(s) of analysis in the Batch Record (Appendix 1, Section 1). 

 Record the Patient ID, CTEP/Protocol number and Slide numbers in the Batch Record 
(Appendix 1, Section 1). 

 Comments on extraction and analysis of individual slides or images can be made in the 
comments section of the Batch Record (Appendix 1, Section 2).   

 Annotate and extract slide images located on the Aperio eSlide Manager database 

Note: See Appendix 2 for calibrator/control and clinical slide section orientation.   

 Retrieve each clinical slide within the clinical eSlide Manager database and open 
individual images using Aperio ImageScope, following these steps (also depicted below): 
Login into Aperio eSlide Manager (A), and click Continue button (B).  Click Cases 
(folder) icon (C) and select the project of interest by clicking on the file folder next to the 
project number (D).  Click on the brain icon next to the patient of interest (E), and open 
the digital slide by clicking on the slide image (F).  The slide image should have opened 
in ImageScope (example shown in G). 

A.  

B.  
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C.  

D.  
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F.  

 

G.  
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 For each patient, create a Header Folder on the Definiens Drive.   

Clinical data within NCTVL at FNLCR must be stored in the CLINICAL folder: Definiens Image 
Upload > PADIS > CLINICAL > specific Trial folder-> BetaCat gH2AX pNBS1 Triplex IFA.  
The suggested naming convention for this Header Folder is: CTEP#_patient ID#.  For example:  
Definiens Image Upload Y: PADIS\...\ 9483_1010080.  Under the Header Folder, 6 subfolders 
should be created: one patient workplace, two Calibrator marker workplaces, and three folders for 
the images.  For details on how to create each subfolder see the sections below, and note the 
figure after section 7.3.3 as an example of subfolder structure. 

 Create one patient workplace subfolder, where the Definiens analysis data will be stored.  
This folder should be named CTEP#_Patient ID Workplace (for example: 9483_1010080 
Workplace).  The workplace subfolder is created in Definiens Architect XD.  The 
operator is prompted in Definiens Architect to name a folder and to designate the location 
the folder should be placed.  Assign the Workplace folder to the appropriate header 
folder.   

 Create two subfolders for the calibrators.  These should be named CTEP#_Patient ID# 
Calibrator Marker (gH2AX or pNBS1) Workplace (for example: 9483_1010080 
Calibrator gH2AX Workplace).  It is critical to specify which calibrator marker is being 
analyzed in the subfolder title.  For the calibrator slides only, separate folders are 
generated for each marker.  The operator is prompted in Definiens Architect to name a 
folder and to designate the location the folder should be placed.  Assign the Workplace 
folder to the appropriate header folder.     

 Create three subfolders for extracted images: 1) patient images (e.g. 9483_1010080 
Images), 2) calibrator gH2AX images (e.g. 9483_1010080 Cal gH2AX images), and 3) 
calibrator pNBS1 images (e.g. 9483_1010080 Cal pNBS1 images).  The image extraction 
subfolders should be made when the header folder is made.  When the same calibrators 
are used for slides from multiple patients on the same staining run, the calibrator images 
can be stored in just one patient folder to save memory space.  If the images are not 
stored in the patient header folder, their location should be noted in the Excel Spreadsheet 
on the Definiens Data sheet under the data. 

 
 General requirements for the extraction of images 

 For clinical tissue sections on all clinical slides analyzed, capture regions of interest 
(ROI) representing images covering the entire analyzable area, using the nearest adjacent 
pathologist-annotated H&E slide image as a guide (see figure below as an example of an 
annotated H&E slide).  It is not necessary to extract images from all possible ROIs.  For 
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most clinical biopsies 8-10 optimal ROIs spanning across the length of the analyzable 
areas of the tissue is recommended.  For lower tumor content biopsies and those with 
sparse tumor areas throughout the biopsy, it may be necessary to extract additional fields 
in order to achieve the requirement of 3000 cells analyzed per two slides required to 
report data for an individual tissue. The maximum number of images to be acquired per 
tissue per slide is 15.  Overlap in ROI selection should be avoided.  Verify that the 
regions of interest are in clear focus on the stained slides.  Annotate and extract images 
from the Aperio scan representing only the analyzable area for the clinical tissue 
sections; avoid edges, necrotic areas, large gaps in the tissue, normal tissue areas or areas 
where the tissue has folded onto itself. 

Tissues visualized in Aperio ImageScope software are given “false” color assignments: 
γH2AX signal is assigned green (Alexa Fluor 488), pNBS1 signal is assigned red (Alexa 
Fluor 647), β-Catenin signal is assigned yellow (Alexa Fluor 546) and DAPI signal is 
assigned blue, as depicted below. 

β-Catenin has been shown to permit delineation of tumor tissue from surrounding tissues.  
All tumor areas extracted for analysis from the pathologist-annotated area should be 
confirmed to be positive for β-Catenin.  The intensity profile of the β-Catenin signal can 
be adjusted to optimize visualization. 

PATHOLOGIST ANNOTATED H&E SLIDE 
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To adjust the β-Catenin signal, follow these steps (also depicted below): Click the 
Image tab, select “Fusion Adjustment” from the drop-down menu, and the “Image Fusion 
Adjustment” dialog box will appear (A).  On the dialog box turn off all colors but yellow 
(β-Catenin signal) by clicking each eye-icon next to the colored box.  Click on the sun 
icon to open the adjustments for brightness, contrast, and gamma (B).  Change the 
parameters by using the slider bar until the desired intensity is achieved, and then click on 
the eye button at the top to turn all the colors back on.  The intensity of the measured 
biomarkers γH2AX and pNBS1 should not be adjusted. 

 

 

 
 For control slides, a minimum of six non-overlapping fields are required for pNBS1 and 

γH2AX calibrator tissues.  Avoid regions on the edge of the tissue and regions of 
necrosis (as indicated by rounded up DAPI stained nuclei).  For calibrator material only 
(NOT FOR CLINICAL SLIDES), ROI selection is guided by where the marker is 
present in the calibrator tissue.  For Calibrator slides only: The intensity of the 
measured biomarkers γH2AX and pNBS1 can be adjusted for better visualization.  
Extractions of the negative and positive control tissues are not necessary as they are 
qualitative controls.   

 Image Annotation 

Prior to image extraction, select and annotate the image fields to be extracted. 

 The rectangle tool is used to draw boxes over the target areas.  The size of the rectangle 
can be automated by selecting: Tools > Options > Annotations (as shown below).  In the 
height tab type 1000, and in the width tab type 1000.  Check the box that indicates pixels.  
This is equivalent to approximately 3.10 x 105 µm2.  The dimensions of the annotated 
regions should be kept fixed and should not overlap. 

A B 
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 Holding down the control button on the keyboard prior to clicking the rectangle tool 

(shown below) will automatically create a 1000 x 1000 box, which will allow for faster 
field selection. 

   
 Place the box over the ROI and let go of the control button.  The box will stay on the 

location that it was placed.  Repeat this process to create several ROIs, as shown below.  
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 Annotated ROIs are named in the Aperio Annotation - Detail View display.  Within 
Annotation - Detail View in the “Layer Region” section, type the desired name in the 
“Text” box for every ROI (see figure A below).  Make sure to save the annotations by 
clicking the save button on the top left of the Annotations - Detailed View display.  This 
will save the annotations with the names.  The annotated text will then appear on the 
Aperio image overlay, as shown below (see figure B). 

 Each ROI is named in Aperio for the patient as follows:  

Project# (5 digits)_Patient# (4 digits) space tissue ID (4 digits) space Slide 
space Slide# (3 digits) space timepoint (4 digits) space Image ID (2 digits) 
(e.g. 07977_0039 500a Slide 007 C1D1 03).   

 Annotation names for calibrators are as follows:  

Date (yy/mm/dd) (6 digits) space Lot# (8 digits) space Slide space* Slide# (2 
digits; *exception: no space after the word “slide” if slide# is 3 digits, for 
example Slide103) space Marker (5 digits) space Cal# space Image# (2 digits) 
(e.g. 180831 14014320 Slide 03 gH2AX Cal2 04).  Note that the Aperio Image 
ID can be used instead of the date; however, if the Aperio Image ID is only 5 
digits, 2 spaces instead of one are required after the ID.   

The 3 levels of Calibrators will be named as Cal1, Cal2, and Cal3, which will 
indicate the following: 

Cal1 = Cal Low 
Cal2 = Cal Mid 
Cal3 = Cal High  
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A 

B 
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 Extraction of Annotated Images 

 Hold down the control button on the keyboard and click the extract image tool button, as 
depicted below (A).  An extraction box will appear (shown as a white square in B).  Still 
holding down the control button, drag the extraction box until it completely overlaps with 
the annotation box (shown as a blue square in B).  Let go of the control button and the 
extraction box will stay in place.   

 
 

 An “Extract Image Region” dialog box will appear.  In the dialog box set the width and 
height of the extracted image as 1000, as shown below (A). 

 Each annotated ROI is extracted as an SVS file (JPEG2000 file) and saved to the 
Definiens drive.   

Select “Output File” in the dialog box and give the image to be extracted a name 
matching the annotation name as shown below (B).  Save the image to the appropriate 
Header folder on the Definiens drive (see section 7.3).   

 Press “Extract” in the dialog box (C).  Once the region is extracted, press “Close” to exit 
the dialog box.  Repeat the process for all the annotated ROIs to be extracted for the same 
sample.  

 
 

A 

B 
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A 

B 
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When you have finished extracting all the images acquired for that tissue, zoom out to 
view the entire tissue and use the Snipping Tool on your PC to copy and save a snapshot 
of the annotated image.  Do this for each timepoint.  An example snapshot of the ROIs 
for two passes of C1D1 is shown below. 

After completing and saving image extractions, close the ImageScope software and log 
out of the Aperio clinical image database.  

Image Analysis 

C 
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 Open Definiens Architect DDR Build.  Go to Definiens Image upload (within NCTVL at 
FNLCR this is located at: \PADIS\CLINICAL\DEFINIENS ARCHITECT DDR BUILD) 
and open XD27_Architect Leidos folder.  Double click on DIA Client.  There will be a 
pop-up box to Run the file, as shown below.  

 
 Go to the Configure tab and click on “Add assays” (as shown below, A), and another 

window will open (B).  Select DDR2 assay and click “Add” (C).  Close the Add Actions 
window. 

 

 

A 
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 If the assay was correctly added, the Analysis Builder: Leidos_Phase II 1.0.0 -box will 

appear toward the bottom left hand corner of the screen, as shown below.  

B 
C 
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 Click on the “Load” tab, and select “Import Folders”, as shown below. 

 
 Under Select Image Data Location, browse and select the specific patient slide folder 

containing the SVS images to be analyzed from the Definiens drive (must be Definiens 
drive and NOT a local drive or the program will not analyze the data or generate a report) 
and then press “Next”.  A screen shot of the import image dialog box is provided below.  
NOTE:  Each calibrator slide must be analyzed separately from patient specimens and 
each patient must be analyzed individually in a customized manner due to morphological 
differences.  Therefore, load only images from one patient or from one calibrator.  

 
 

 Under Select Scanner Type choose “Aperio Scan Scope FL-with resolution” from the 
drop-down menu and press Next, as shown below. 
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Under Workspace Name type the workspace analysis folder name (as shown below).  
There should be separate workspaces for clinical slides and for calibrator slides.  For 
clinical tissues, the workspace should be named CTEP#_Patient ID# Workspace (e.g., 
7977_1010012 Workspace).  For calibrator tissues, the workspace should be named 
CTEP#_patient ID space Calibrator space Marker name Workplace (e.g., 7977_1010012 
Calibrator gH2AX Workplace).  Under Select Workspace Storage Location, browse and 
select the same header folder on Definiens network location where the SVS images are 
stored, then press Finish. 

All image files in the Definiens folder should be downloaded into the Definiens 
Workspace.   

Define a Training Set from the loaded image list in the Workspace. 
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The training set will be used to teach the Definiens software to segment and threshold all 
images.  A maximum of 12 images can be selected for the training set.  To select multiple 
images, hold the control key on the keyboard and, using the mouse, click on the images 
from the image list that are to be included in the training set.  Make sure to include 
images from all timepoints.  Right click on the list of images, and a dialog box will 
appear (as shown below in A).  Select “Define Training Set”, and another dialog box will 
appear asking for the Training Data Set name (B). Enter the name of the training set and 
click “OK”.  This will load the Training Image Set.  Using the maximum number of 
images (12) for training is important to get the best results for tissue segmentation and 
marker thresholding.  

A 
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 When the images have loaded, click on the Configure tab as shown below. 

 

 
 Set the Image Source settings, as shown below in A.  Select the File Source as Aperio 

Widefield (16 bit - 0.4622um/pxl).  Enter the correct resolution µm/pixel if different than 
0.4622.  Check box next to “Use Training Set”.   

B 
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The Pane Layout can be set between 1- 4.  However, if you select to view more 
than one pane, adjusting the zoom will result in only one image being zoomed.  
If you wish to view more than one pane, you can do this by clicking Image 
View Control above the image view (as shown below, B) and selecting a multi 
map view.   

Adjust the image layer mixing to assign colors to markers.  

Go to View, and select “Image Layer Mixing” as shown below (A).  Edit Image Layer 
Mixing pop-up box will appear (as shown below, B).  Select “none” from the Equalizing 
drop-down menu.  Assign correct colors to each marker: Layer 1 (pNBS1) – red; Layer 2 
(B-Cat) – red and green; Layer 3 (gH2AX) – green; and Layer 4 (DAPI) – blue.  To 
select the color, click on the color box, and a circle will appear when the color is selected.  
Click “OK” to accept changes. 

Set the Marker Assignment and Screenshot Equalization settings. 

A 

B 
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Assign Layer 4 to Nucleus and adjust the Nucleus Equalizer Low and High, as 
depicted below.  The intensity range should be 0-65535.  If the nuclear signal 
appears weak, a shorter range may be needed. 

Assign Layer 2 to Tumor Marker and adjust the Tumor Equalizer Low and 
High to best visualize the β-Catenin signal, as depicted below.  If the tumor 
signal appears weak, a shorter range may be needed. 
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Assign Layer 1 to pNbs1, as depicted below.  Adjust equalizer to the full 
intensity range (low=0; high=65535). 

Assign Layer 3 to gH2AX, as depicted below.  Adjust equalizer to full 
intensity range (low=0; high=65535). 

Set thresholds at ROI Selection 

Select “Tumor” from Tumor selection drop down menu, as depicted below.  
The images will change to the β-Catenin images automatically.  Adjust the 
Auto-threshold Sensitivity -slider until the β-Catenin signal is masked.  This 
will take some time for the first selection, but additional adjustments are faster. 
It is not necessary to click Run, as the mask will automatically update when 
you adjust the auto-threshold sensitivity.  The larger the number the more 
sensitive the thresholding.  
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Examples of under-thresholded, over-thresholded and correctly thresholded 
image masks for β-Catenin are shown below. 

Evaluation of calibrator tissue and clinical tissues that do not require β-Catenin 
segmentation 

Calibrator slides should be analyzed separately from clinical slides.  The 
calibrator tissues within the biomarker control slides have little β-Catenin 
positivity and do not require tissue segmentation.  For segmentation of 
calibrator tissue, the user can select Whole Field from the drop-down in the 
ROI Selection (see below) or raise the auto-threshold sensitivity until the 
whole tissue is masked. 

Nuclear Segmentation tab 

Nuclear segmentation is automated so there are no adjustments to be made.  You can 
click on Run to view the nuclear segmentation, but it is not necessary. 

Analysis Tab: pNBS1 

Adjust the pNbs1 threshold, as shown below.  Values can be typed in or the slider can be 
used.  The pNbs1 image will open when you adjust the threshold. 
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The marker mask can be toggled on and off by clicking the show/hide classification of 
objects icon, as shown below. 
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Examples of under-thresholded, over-thresholded and correctly thresholded image masks for 
pNBS1 are shown below. 

Analysis Tab: γH2AX 

Adjust the γH2AX threshold, as shown below.  Values can be typed in or the slider can 
be used.  You do not need to check the “Apply foci size” for these markers.  The larger 
the value the less sensitive the thresholding.  

The marker mask can be toggled on and off by clicking the show/hide classification of 
objects icon, as shown below. 
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Examples of under-thresholded, over-thresholded and correctly thresholded image 
masks for γH2AX are shown below.  

Save Solution 

Go to the Configure tab and click “Save Solution”.  Save solution to the folder containing 
the current workspace.   

Data analysis 

Assign Job Scheduler.  Go to File>Configure Analysis.  Within NCTVL at FNLCR, 
select http://fr-s-dtp-378apr:8184/ from the drop-down and click OK, as shown below. 

Go to Run tab and click on “Analyze all Images”.  When the status of the last file changes 
from “Processing” to “Processed” the quantitation is complete.   
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View Data Analysis and Image Screenshots 

The Definiens images are located in the header folder in the Workplace subfolder.  In the 
Workplace subfolder open the results folder (as shown below), and there open the Excel 
“Project Statistics” file.  Nuclear counts are located in Column D, %NAP pNbs1 in 
column F and %NAP gH2AX in column H.  
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 To view the image screenshots, open ExportView (see above), select View tab as shown 
below, and select to view icons as “Extra Large”. 

  

 For QC purposes, all the analysis parameters are saved in the results folder named 
“parameters”. 

 
 Note: As discussed in more detail in Section 8.2.2, all screenshots must be inspected, 

including comparison of masked areas to gray-scale images, to determine that 
thresholding and segmentation were correctly applied.  If it is apparent that the marker 
mask is detecting inappropriate signal (i.e. collagen, autofluorescence, tissue folds, 
debris or other factors that interfere with nuclear detection) individual fields can be 
removed from analysis.  However, no more than 20% of the images can be removed from 
an analysis.  If more than 20% of the images have an issue, the training set may not have 
been representative of all the images and the analysis will have to be rerun. 
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8.0 QUALITY CONTROL, DATA ANALYSIS AND REPORTING 

 Biomarker Specific Control Slide QC and Data Analysis 

Variability in sample processing and staining is monitored by employing biomarker 
specific control slides.  At least one γH2AX and one pNBS1 biomarker control slide are 
included in each staining run and should be evaluated to confirm that acceptable levels of 
the Cal1 (Cal Low), Cal2 (Cal Mid) and Cal3 (Cal High) for both biomarkers fall into the 
range acceptable as determined for each lot of calibrator slides.  A slide layout for each 
biomarker specific control slide is shown in Appendix 2. 

Additional controls included on the control slides are evaluated qualitatively.  
The current γH2AX and pNBS1 control slides include a section of murine testis 
and jejunum.  

The jejunum should be very low or negative for both γH2AX or pNBS1.  If 
minimal staining for γH2AX is observed, it should be limited to the crypt cells. 

The mouse testis should be negative for pNBS1 in the nuclei throughout.  Some 
non-nuclear staining may be observed in the center of a small subset of tubules. 
The spermatogonia, spermatocytes, and spermatids should be intensely stained 
for γH2AX.  

Open the Clinical Specimen Analysis Excel Template for the calibrators.  The template is 
located on the Definiens drive at: \PADIS\Solutions\SOP340545 
gHAX_pNBS1_BCat_New Build Master Template. The template will be used to analyze 
the clinical and calibrator data. 

In the Excel spreadsheet generated by Definiens in the Calibrator Workplace subfolder 
open in the results folder > open the Excel “Project Statistics” file.  Nuclear counts are 
located in Column D, %NAP pNbs1 in column F and %NAP gH2AX in column H.  Copy 
the spreadsheet and paste into the appropriate Cal “Marker” raw sheet in the Master 
Template.  

The acceptable levels for the calibrator slides will be determined by lot.  At least one of 
each Cal1, Cal2 and Cal3 on each of the two calibrator slides should pass QC to proceed 
to the clinical analysis.   

In some cases, there may be an isolated calibrator slide failure that is slide specific.  If all 
controls pass on the remaining slides, and the failure to achieve acceptable %NAP on the 
control slide is thought to be a slide failure and not an assay failure, the Laboratory 
Director/Supervisor may allow exceptions to QC.  In this event, an additional control 
slide should be run with all the same critical reagents within 7 days to confirm that the 
failure was isolated to that individual slide. 

Clinical Slide QC and Data Analysis 

As described in SOP340550, murine testes and jejunum tissues are fixed and processed in 
parallel with the clinical biopsies.  The testes and jejunum controls on these slides serve 
as controls for both proper tissue fixation and staining of γH2AX and pNBS1 and are 
assessed qualitatively as described above in Section 8.1.1.  If these criteria do not pass for 
staining of γH2AX and pNBS1, the clinical slide should not be evaluated, and the 
potential source of the error should be evaluated. 

QC of Screenshots 
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Images for Quality Control evaluation of screenshots of clinical tissue ROI can be viewed 
in the Export View folder in the Results folder.  Images should be displayed as extra 
large icons. See images below.  

 
 Visually inspect every screenshot and compare masked areas to gray-scale images to 

determine that thresholding and segmentation were correctly applied for each image.  The 
following criteria should be met:  1) the β-Catenin segmentation should accurately reflect 
that only β-Catenin positively stained tumor tissue is included in the analysis, and 2) the 
marker threshold should accurately capture marker positive cells.  If tissue segmentation 
is not correct due to the marker threshold being too high or low, , or if more than 20% of 
the images would need to be removed from the final analysis the training set may not 
have been representative of all the images and the analysis may need to be run again.  For 
the second training set select images with suboptimal thresholding.  If it is apparent that 
the marker mask is detecting signal other than tumor cell specific expression (i.e., 
collagen, autofluorescence, tissue folds, any features that interfere with nuclear detection) 
those fields should be noted for removal from analysis.  

 Note Shortcut: If after reviewing the screenshots it is determined a new training set or 
different thresholds are needed and the Definiens Architect is still open, the Workspace 
can be reset.  Click on the Run tab.  Select “Reset workspace”, select existing training set 
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or create new training set.  Go back to the configure tab and work down through the 
script again. 

 In order to report data for each individual clinical biopsy pass, the sum of cells from  two 
non-adjacent slides must be ≥3000 cells.  Although data can be reported from more than 
two slides, it is required that each tissue reaches this cell number across two non-adjacent 
slides in order to ensure that data is reported from tissues of adequate quality. 

 How to use the SOP340545 γH2AX_pNBS1_βCat New Build Master template 

1. Open SOP340545 γH2AX_ pNBS1_ βCat New Build Master template and save it as 
SOP340545 gH2AX_pNBS1_BCat New Build Analysis CTEP#_Patient#, i.e. 
“SOP340545 gH2AX_pNBS1_BCat New Build Analysis 7977_1010056” in the header 
folder. 

2. Copy data from the Definiens Architect DDR Build for the Specimens. This is located in 
the header folder > CTEP Workplace folder > results folder > Project Statistics Excel file. 

3. Paste the copied Definiens Architect DDR data into the Excel Template on the 
"Definiens Data" Sheet. 

4. On the "Definiens Data" sheet, images that need to be removed from the final analysis 
due to tissue, staining or other problems, should be highlighted (bright yellow).  All 
images should be reviewed before running the template macro.  Images are located in 
Header folder > CTEP Workplace folder > results folder > ExportView folder.  If more 
than a few images are removed, a comment should be made right below the pasted data 
why the images were removed from the analysis.  This page is not part of the macro 
analysis but serves as a means verify and to audit data.  (Suggestion: when multiple 
images must be removed, paste a screen shot of an example image.) 

5. Copy the data from the Definiens Data Sheet including the column headers and paste it 
into "Raw Data 1" sheet.  Don't copy the comments made on the Definiens Data sheet. 

6. In "Raw Data 1" sheet remove all highlighted rows and make sure the images were 
named correctly before using the Macro.  Most macro failures are due to image naming 
errors. 

7. Copy the data from the Definiens Architect DDR Build Data Analysis for each calibrator 
(gH2AX & pNBS1).  These are located in the header folder > Marker Workplace folder > 
results folder > Project Statistics Excel file. 

8. Paste the appropriate data into the Excel template sheets “Cal gH2AX raw” or “Cal 
pNBS1 raw”.  Make sure the images were correctly named. 

9. Go to the Developer tab and select the Macro “DDR3_NEWBuild”.  When the macro has 
completed, it will go to the “Lookup” sheet.  

10. Go to the “Cal Analysis & Summary” sheet and type the required information into the 
“Enter Information” boxes for each Marker Calibrator.  In the appropriate boxes put the 
calibrators’ limits, exposure time, and threshold information (the adjacent table will 
indicate if the calibrator slides passed QC for each calibrator level).  At the top of the 
page, in the yellow box, put the date the slides were imaged.  

11. Check all pages for errors.  For example, the “Lookup” sheet has totals.  Compare the 
totals to the number of raw data images analyzed.  Make sure that on the “Template 
Analysis” and “Cal Analysis & Summary” sheets the data is present in all cells that 
should have it contain data. 
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12. Check the “DDR3 Summary” sheet to make sure that the requirement of 3000 cells for 2
slides per pass is met.  The table “2 Slide Max Nuclei Value/Pass” should say “Pass” for
each biopsy pass.  If there is a “fail” for a biopsy pass, the data from the pass cannot be
used in the final data report.  Make a comment on the “Definiens Data” sheet why the
data will be removed and highlight the data selected for removal.  Copy the Definiens
data and paste it into the “Raw Data 1” sheet.  Remove all highlighted data.  Run the
macro and review the data.

13. On the “Data Report” sheet, type in the name of the operator and the date of the report.
Indicate if the calibrator slides passed QC (Pass or Fail).  Review the data report of
accuracy and completeness.  If needed, make comments in the Additional information
section.

14. The Data Report must be finalized.  The supervisor needs to sign the data report, which
indicates that the supervisor reviewed the report and found it to be complete and accurate.

15. Image Naming Requirements for Specimens (NOT CALIBRATORS):

• Project# (5 digits)_Patient#(4 digits) space tissue ID (4 digits) space Slide space
Slide# (3 digits space timepoint* (4 digits) space Image ID (2 digits)

For example, if the project is 7977, patient is 39, timepoint is pre, slide is 5, 
image is 8, and the specimen ID is 500a, the image should be named: 
07977_0039 500a Slide 005 C1D0 08 

• *Timepoints must be indicated with 4 characters.  For example:

o Pre-dose/Screening of the first cycle = C1D0
o 2 hr post dose of the first cycle = D1H2
o 4 hr post dose of the first cycle = D1H4
o Day 1 post dose of the first cycle = C1D1
o Day 8 post dose of the first cycle = C1D8

16. Image Naming Requirements for Calibrator tissue (2 choices):

A. Aperio Image ID (5-6 digits) double space (if 5 digit Aperio image ID is used) Lot#
(8 digits) space Slide (slide) Slide# (2 digits) space Marker (5 digits) space Image #
(2 digits). 

spaces      ↓↓         ↓      ↓ ↓   ↓    ↓ 
example: 55553  14014320 Slide 03 gH2AX Cal2 04 

B. Date of Staining (6 digits – yy/mm/dd) space Lot# (8 digits) space Slide space
Slide# (2 digits) space Marker (5 digits) space Cal# space Image # (2 digits)

spaces  ↓     ↓     ↓ ↓ ↓    ↓ 

Cal1 = Cal Low 
Cal2 = Cal Mid 
Cal3 = Cal High 
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 example: 180831 14014320 Slide 03 gH2AX Cal2 04 
  

17. Other information:  

A. Complete name by Definiens: Tissue Slides.180831 14014320 Slide 03 pNBS1 Cal3 
01 

B. If the slide number for the calibrator is 3 digits instead of 2 digits, do not put a space 
after the word Slide (for example, slide number 105 becomes Slide105). 

C. Definiens DDR3 New Build Analysis program will add the words "Tissue Slide." 
before the name that was given to the extracted image. (Tissue Slide. MUST 
appear in front of the name for the Macro to work correctly.) 

 

 In the Batch Record enter the name and location of the header folder (Appendix 1, 
Section 1).  All associated files should be located under the header folder CTEP number, 
and patient ID.  The related calibrator files can be copied and placed in the header folder.  

 Document ANY and ALL deviations from this SOP in the Batch Record (Appendix 1, 
Section 2.) 

 Complete, review and finalize the Batch Record (Appendix 1) and obtain required 
signatures (Appendix 1, Section 3).   

 The Data Report in the Excel Master Template should be completed by the operator 
including entering the operator’s name, date of the report, indicate if the calibrator slides 
passed/failed QC.  The report should be reviewed by the operator for accuracy and 
completeness.  The supervisor needs to sign and date at the bottom of the Data Report 
(Appendix 3, Appendix 4).  The supervisor indicates by signing the report that it the data 
report has been reviewed and was found to be accurate.  
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APPENDIX 1:  BATCH RECORD  
 
A. Image Extraction and Analysis 

 
B. Comments: 

 
 
 
 
 
 
 
 
 
 
 
 
C. Laboratory Director/Supervisor Review of Batch Record 

Laboratory Director/Supervisor:     (PRINT) 

     (SIGN)
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APPENDIX 2: CALIBRATOR/CONTROL SLIDES AND CLINICAL SLIDES 
A. Calibrator/Control Slides 

1. Biomarker specific control slides are required for each clinical Bond-RX run.  The layouts of the 
biomarker specific control slides used for this SOP are shown below.   

 

 

 
 

2. Controls included on the control slides are evaluated qualitatively.   

a) The jejunum should be very low or negative for γH2AX and pNBS1.   

b) The mouse testis should be negative for pNBS1 in the nuclei throughout. Some non-
nuclear staining may be observed in the center of a small subset of tubules. The 
spermatogonia, spermatocytes, and spermatids should be intensely stained for γH2AX. 
An image of the testis control showing intense staining for γH2AX is shown below.  

 
 

 

3. γH2AX & pNBS1 Calibrator Section Criteria 
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a) Calibrator sections are generated from NBF-fixed, paraffin-embedded mouse xenograft 
tumor quadrants derived from vehicle and drug treated animals representing 
three different levels of biomarker expression (Calibrators [Cal]: (1) Low, (2) Mid, and 
(3) High).  The calibrators serve as a visual reference standard for drug-effect on target. 

b) The specifications for acceptable biomarker levels in the calibrators are determined by 
control slide lot.  
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B. Clinical Slides 

1. Clinical samples for this assay will be frozen needle biopsies collected according to SOP340507, 
embedded and sectioned according to SOP340550, and stained for γH2AX, pNBS1, and B-Cat 
according to SOP340543.  A representative clinical slide layout is shown below.  In some cases, 
there maybe two passes embedded for each time point (see this layout in SOP340550). 

 

 

2. Two or three slides are pre-stained with H&E and are used to evaluate the tissue quality prior to 
γH2AX, pNBS1, and B-Cat staining. 

3. Typically, slides submitted for IFA staining represent every third or, in smaller slides sets, every 
second section from the range of slides determined to be optimal based on visual inspection and 
H&E evaluation.   

4. Backup slides are available for use if the first slide set does not meet QC criteria for biomarker 
staining and analysis. 
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APPENDIX 3: CLINICAL SAMPLE DATA REPORT 
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APPENDIX 4: EXAMPLE OF CLINICAL SAMPLE DATA REPORT 
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